DESCW Interface

About this Chapter

This chapter explains DESCW's screen interface and how to use it. If you are new
to using DESCW, you will learn how to choose commands, select dialogue box
options, and work with the program’s windows. Even if you are an experienced
user, you will find valuable information about new and improved features such as
the Toolbar and the Layers Map.




You can start DESCW by selecting it from the Programs Menu, or double-
clicking the DESCW EXE file (the executable file with the satellite icon) in
Explorer. A dialogue box will be displayed with the Tip of the Day or with the
What's New screen (the default); you can choose Next Tip or Close the
window. Before closing, you can take the option to request that this dialogue
box is not displayed at start-up.
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This section provides an overview of the major elements of the DESCW screen:
its Menus, the Toolbar, and the Status bar.
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At the top of the screen the Menu bar is displayed. Just below it, the Toolbar
allows quick access to commonly used commands.

DESCW Interface

2-2



You can choose a command by:
¢ Selecting it from a menu
¢ C(Clicking a Toolbar button with the mouse (for most commands)

At the bottom of the DESCW screen the Status bar gives information about
the current active task.

When you first start DESCW, the Toolbar is displayed below the Menu bar.

Commands on each of the menus are detailed below with the corresponding
Toolbar icon (not all commands have a Toolbar equivalent).

File Menu

EI New

Starts a new search session, deleting any search parameters from the
previous session.

L'}
|i'| Load Parameters

Loads previously saved search parameters or user area.

El Save Parameters

Saves all the current search parameters or only the Scene List content.

Load User Area

Loads a pre-defined user area.

Save User Area

Saves only the user area (the defined polygon, quadrilateral or circle).

Load User Request

Loads a pre-defined user request.

Save Zoom Window

Saves a picture of the Zoom window with a choice of format (BMP, JPEG, EPS,
etc.).
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Collections

Create Interchange Format File(s)

To save the Scene List content in the DESCW Interchange format.

Convert Interchange Format to binary
To convert a DESCW Interchange format file into a DESCW binary file.

Print Setup

To select and customise the printer.

%l Print

Lets you:
Print the Zoom Window

Print the Scene List Window.

Print preview

Shows a preview of the two print options.

Print setup

Opens the Printer Setup dialogue window to select printing options.

Edit Menu

Delete Unselected

Deletes unselected scenes in the Scene List Window.

KT} | Undo

Reinstates deleted scenes in the Scene List Window and Zoom Window.
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“l Modify Colours

Modifies the colours used by DESCW to distinguish the various elements in
the Zoom Window and the Scene List Window.

View Menu

i‘i Navigation map

Opens/closes the Navigation Map Window.

?‘ Zoom Window

Opens/closes the Zoom Window.

Scene List

]

Opens/closes the Scene List Window.

Lat-Long Grid

¢

Enables/disables the geographical grid on the Zoom Window.

Satellite Sub-track

4

Shows satellite tracks of the selected missions.

Satellite Position

Shows the Satellite(s) position, for some satellites only, according to the
computer date/time.

-l Polar co-ordinates

Toggles between the Mercator and the Polar projection in both the
Navigation Map and the Zoom Windows (Mercator is the default).
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Show Area Names

Displays the name of the user defined search Area(s) in the Zoom Window.

Full Coverage

Displays all the scenes retrieved by the query in the Zoom Window without
saving them in internal storage. This option closes the Scene List Window.

Selected Coverage

Enables the saving in internal storage of the scenes retrieved by the query
in the Zoom Window (details of saved scenes can then be displayed in the
Scene List Window, thus allowing you to further define your scene
selection). By default only the first 800 scenes will be saved.

Toolbar

Shows/hides the Toolbar. Under Windows 95 the Toolbar is floating.

Status bar

Shows/hides the Status bar, used for displaying system messages, quantity
of retrieved scenes, area names and sizes.

Zoom x 2

|®

Zooms in within the Zoom Window.

Zoom =+ 2

|

Zooms out within the Zoom Window.

El Scene Details

Opens the View Scene Details Window.

Split View

Allows the Quick Look to be opened in multiple windows.
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Station Availability

Shows the periods of availability of those Ground Stations that operate on
campaign basis.

Plan Availability

Shows the periods of availability of ERS ascending passes for the SAR in
Image Mode.

Menu

Mission

Opens the Missions and Filters Window, where the user can define which
missions to include in the search and the search parameter settings for the
time range of acquisition, acceptable cloud cover, acquisition station, etc.

Area

Changes the cursor into a cross-hair with which the user can define a
polygonal search area in the Zoom Window. This option also deletes any
previously defined search area.

Area Coordinates / Name

Opens the User Area Definition Window, where an area can be defined as
one of:

a quadrilateral of Lat/Long co-ordinates

a circle with a radius in km around a Lat/Long co-ordinate

an area via its name from a pre-defined list, resulting in a circle or polygon
around a place (city or country)

The selection is displayed as a polygon on the map in the Zoom Window.

Note that the first two definition options also let you enter a name for the
geographical area chosen (through the input dialogue windows or in the
Status bar).



Quick Look Directory

Defines the drive and directory on which the Quick Looks corresponding to
the scene selections can be found.

Scene List limit

Permits extending the limit of 800 scenes up to 10.000. Note that increasing
the limit will require more memory and that the scene list window can in
any case display only a maximum of 2000 scenes.

E}‘l Map Layers

Defines which layers of geo-political information should be displayed on the
map in the Zoom Window and the resolution to use.

Thematic Maps

Opens the Thematic Map Window allowing you to select the required
map(s) and value range(s).

User Info

To retrieve on-line data from DESCW some user data are requested, such as

e-mail and FTP port.

Remote Server Info

Reserved for future use.

Log In Info

To retrieve on-line full-resolution data, or to access restricted features a User

Identification is requested.

Search Menu

Gﬂ'l Start

Starts a search with the selected parameters.
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Enable Auto Search

When this option is selected, the search will automatically start after a new
parameter has been defined. Auto Search is enabled by default, but you may
prefer to disable it while getting to know DESCW.

Enable Area Filter

This option enables/disables the geographical Area filter defined by the
polygon in the Zoom Window. If enabled, only scenes wholly or partly in the
search area polygon will be included in the Search. If the filter is disabled,
the Search facility will locate all scenes within the area shown by the Zoom
Window. The filter is enabled by default.

Database Menu

Image -> Text Database

Opens the Image Database dialogue box used for searching images and

documents from specific collections.

Window Menu
Reposition Windows

Returns the DESCW windows to their default positions.

Help Menu

ﬂl About DESCW

Shows the software version, credits and computer status information.

Tip of the Day

Shows the Tip of the Day dialogue.

Show News

Opens a dialogue box that shows the new features of the version in use.
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Launches the DESCW on-line Help facility.

Status Bar

The Status bar at the bottom of the DESCW screen provides information
about the active process and also gives access to certain functions.

To hide the Status bar, disable the Status bar option from the View Menu.
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From the left, the fields on the bar show you:
Information about the current process

User search area name and size. If you move the cursor over the field it
changes to a hand holding a pencil. Click on the field and a label ‘Change
User Area Name”is displayed; click on the label and a dialogue box is
displayed letting you change the User Area Name. The software automatically
computes and shows the area size in km?

Number of scenes retrieved by the most recent query

Geographical co-ordinates in degrees and minutes of the mouse position in
the Zoom Window

The Main DESCW Windows

The DESCW software uses three major windows:

Navigation Map Window

The Navigation Map Window is a small map of the Earth where you can
choose the area of interest - the Focus Rectangle - that will be displayed in the
Zoom Window.
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e Zoom Window

The Zoom window is displayed either by selecting the Zoom Window
option on the View Menu or by clicking, or dragging, on the Navigation
Map Window. It expands the area contained in the Focus Rectangle from the
Navigation Map Window, at a level of detail determined by the Map Layers
option. You can zoom in and out using the Zoom options on the View
Menu. Search area polygons can be drawn in this window. When a search
has been completed, frames outlining each of the scenes found are displayed
in the window.

e Scene List Window

When a search has been completed this window will list the scenes found.
Moving the cursor over a column in the window will highlight all scenes with
the same value in that column. For example, if the cursor is over a number in
the Track column, DESCW will highlight all scenes with the same Track
Number; the same scenes will also be highlighted in the Zoom Window.
Double clicking on the Status column of a scene will display its Quick Look (if
available) asking for a CD-ROM or opening a FTP connetcion with one of the
servers. Clicking on the Status column with the Scene Details option
selected displays the View Scene Details Window.

The complete features of the Scene List Window are detailed in the Reference
section of this manual.

Other DESCW windows allow you to define search parameters, view results,
etc.

e Mission Window

Allows you to select the satellite mission(s) to use in the search, and to set
search filters such as Acquisition Date Range, Acquisition Station,
Acceptable Cloud Cover, etc.

e Viewer Window

Displays Quick Looks (if available) when you click on the Status column in
the Scene List Window. This window can be modified by the Split Views
option.

e Scene Details Window

Displays the scene inventory information.

e FERS Shifted Scene Window

Lets you display and calculate the offset for ERS Shifted Scenes.
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e Landsat Floating Scene Window

Lets you position and select Floating Full Scenes, Quarter Scenes and Mini
Scenes

e User Area Definition Window

Lets you select your area of interest as a rectangle defined by Lat/Long co-
ordinates, as a circle of selectable radius around a Lat/Long-defined point or
as a place name selected from a displayed list. See Chapter 4 for further
details.

e Interferometric Baseline Window

Displays the baseline values for the selected track and frame combination for
ERS—1 and ERS-2.

e Sub-scene Selection Window

Allows authorised users to select and download a portion of a full resolution
scene from a remote server.

e Thematic Map Window
Allows you to select the thematic map(s) to apply to the current search. Two
main representations are possible:
- show the result of the combination of active thematic maps and
categories

- show all the categories of the currently selected thematic maps in colour
scale

DESCW HELP is a separate program from DESCW. You invoke DESCW Help by
clicking the Help button on the Toolbar or through the help option of the
help menu. Use PROGRAM MANAGER, or ALT-TAB, to toggle between
DESCW and DESCW Help while you work.

You can get help about DESCW Help by choosing Contents from the Help
Menu, then choosing How to use Help from the Help Menu.
DESCW help main topics

e What's new
e Starting
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e What is DESCW

e DESCW elements
® Quick Tour

¢ Reference manual
e Troubleshooting
e Acronyms

e Ground Stations
e Ordering Products

e Satellites

Selecting Help topics

There are two ways to select Help topics:
e A hyperlink (displayed as an underlined word) opens a new Help page

e A pop-up_(displayed as a word underlined with a dotted line) opens a pop-up
window containing a short description of the item highlighted.
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